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PRAKTIKUM 1 

STATISTIK DESKRIPTIF 

 

A. Tujuan 

Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk menunjukan  mean, std. error of mean, 

median, std. deviation, variance, skewness, std. error of skewness, kurtosis, std. error of 

kurtosis, range, minimum, maximum, dan percentiles. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Pendahuluan 

Statistik deskriptif merupakan statistik yang berhubungan dengan pengumpulan data, 

penyajian data (pembuatan tabel dan grafik), dan melakukan perhitungan statistik untuk 

mendeskripsikan atau menggambarkan data yang telah terkumpul, dan tanpa membuat 

kesimpulan yang berlaku umum (generalisasi). Bagian ini akan di bahas secara ringkas dan 

statistik deskriptif yang bersifat aplikatif yang mencakup: 

1. Penyajian data. 

2. Tabel distribusi frekuensi dan diagram statistik. 

3. Ukuran gejala pusat dan ukuran letak. 

4. Ukuran penyimpangan atau dispersi. 

5. Kemiringan dan Kurtosis. 
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C. Aplikasi SPSS untuk Statistik Deskriptif 

Berikut adalah data tinggi badan 25 orang mahasiswa (dalam centimeter) yang diambil secara 

acak. 

No Tinggi Gender  No Tinggi Gender 

1 170.2 Pria  14 170.4 Wanita 

2 172.5 Pria  15 168.9 Wanita 

3 180.3 Pria  16 168.9 Wanita 

4 172.5 Pria  17 177.5 Wanita 

5 159.6 Wanita  18 174.5 Pria 

6 168.5 Wanita  19 186.6 Wanita 

7 168.5 Pria   20 164.8 Wanita 

8 172.5 Pria  21 170.4 Pria 

9 174.5 Pria  22 168.9 Pria 

10 159.6 Wanita  23 164.8 Wanita 

11 170.4 Wanita  24 167.2 Wanita 

12 161.3 Wanita  25 167.2 Wanita 

13 172.5 Pria     

 

Gunakan aplikasi SPSS untuk mengolah data tersebut untuk mendapatkan gambaran umum 

dari data tersebut. 

 

Langkah-langkahnya adalah sebagai berikut. 

1. Mendefinisikan variabel. 

a. Data di atas terdapat dua variabel (Tinggi Badan & Gender), maka akan definisikan 2 

variabel tersebut. Pada bagian bawah menu editor data, tekan tombol Variable View. 

Maka akan tampak tampilan berikut: 

 

 

b. Kolom pertama merupakan tempat untuk mendefinisikan nama-nama variabel tersebut. 

Pada baris pertama-kolom pertama untuk mendefinisikan nama variabel ke-1, baris 

kedua-kolom pertama untuk mendefinisikan nama variabel ke-2. Kita ketikan “Tinggi” 

untuk variabel pertama dan “Gender” untuk variabel kedua. 
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c. Untuk deklarasi Type variabel kita gunakan “Numeric” untuk variabel Tinggi dan 

Gender. Nantinya untuk variabel Gender kita pilih angka “1” untuk menandai gender 

Pria dan “2” untuk menandai gender Wanita. 

d. Untuk Width, biasanya standar SPSS untuk numeric adalah 8, kita biarkan saja angka 

8 karena sudah mencukupi untuk keprluan kita. 

e. Untuk Decimals, untuk variabel Tinggi, karena datanya mengandung 1 angka di 

belakang koma, kita pilih 1. Sedangkan untuk gender karena bilangan bulat kita pilih 

angka 0. Untuk itu kita perlu mengganti default yang ada pada editor yaitu 2 dengan 

angka 1 dan 0 tersebut. 

f. Untuk sementara biarkan submenu-submenu yang lain seperti Values, Label, Missing 

dll. Seperti apa adanya. Tampilan akhir dapat dilihat seperti gambar berikut ini. 

 

 

g. Selanjutnya kita akan memasukan data yang kita punya dengan terlebih dahulu 

menekan tombol Data View.   
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2. Langkah-langkah analisis sebagai berikut: 

a. Dari baris menu, pilih menu Analyze, lalu pilih submenu Descriptive Statistics, lalu 

pilih lagi sumenu Frequencies (untuk menampilkan tabel frekuensi). Lalu akan tampil 

gambar berikut ini. 

 

 

b. Kolom Variables(s) harus diisi dengan jenis-jenis variabel apa yang ingin kita analisis. 

Karena ingin dibuat frekuensi dari variabel Tinggi, maka klik variabel Tinggi, kemudia 

klik tanda panah, maka variabel Tinggi akan berpindah ke kolom Vraible(s). 

c. Klik pilihan Statistics, maka akan tampil di layar gambar berikut: 

 

 

d. Pilihan Statistics meliputi berbagai ukuran untuk menggambarkan data, antara lain 

sebagai berikut: 

a. PercentilesValues. Untuk keseragaman klik Quartiles dan Percentile(s). Kemudian 

pada kotak disamping kanan Percentiles ketik 10, lalu tekan Add. Sekali lagi ketik 

90 pada kotak terdahulu, dan klik lagi tombol Add. Pengerjaan ini dimaksudkan 

untuk membuat nilai persentil pada 10 dan 90. 

b. Dispersion atau penyebaran data. Untuk keseragaman, semua atau keenam jenis 

pengukuran Dispersion dipilih semua. 
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c. Central Tendency atau pengukuran pusat data, untuk keseragaman pilih Mean dan 

Median. 

d. Distribution atau bentuk distribusi data. Untuk keseragaman, klik Skewness dan 

Kurtosis. 

 

 

e. Pilihan Charts. 

 

 

Menu Charts berkenaan dengan jenis grafik yang ingin kita pilih. Dari Chart Type, 

untuk keseragaman kita pilih Histogram. Lalu menu With normal curve-nya akan 

hidup, maka kita klik juga With normal curve. Lalu klik Continue. 
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f. Setelah menu Format diklik, maka akan tampil gambar berikut: 

 

 

Pada submenu Order by (data output akan disusun seperti apa) kita seragamkan saja 

dengan memilih output akan disusun naik (dari data terkecil ke data terbesar). Untuk 

itu pilih Ascending values. Selanjutnya klik OK. Maka semua proses pengisian dan 

pengolahan data telah selesai, dan kita akan lihat hasilnya (outputnya) pada editor 

Output. 

 

3. Output SPSS dan Analisisnya 

Selanjutnya data yang telah kita olah tersebut akan kita lihat outputnya. Berikut ini adalah 

output dari Descriptive. 

Statistics 
Tinggi   

N Valid 25 

Missing 0 

Mean 170.120 

Std. Error of Mean 1.2066 

Median 170.200 

Std. Deviation 6.0328 

Variance 36.394 

Skewness .572 

Std. Error of Skewness .464 

Kurtosis 1.460 

Std. Error of Kurtosis .902 

Range 27.0 

Minimum 159.6 

Maximum 186.6 

Percentiles 10 160.620 

25 167.200 

50 170.200 

75 172.500 

90 178.620 

Output Bagian Pertama (Statistics) 

a. N atau jumlah data yang valid adalah 25 buah, sedangkan data yang hilang (missing) 

adalah nol. Ini artinya semua data bisa diproses 
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b. Mean atau rata-rata tinggi badan adalah 170,12 cm dengan standar error adalah 1,20655 

cm. Penggunaan standar error of Mean adalah untuk memeriksa besar rata-rata populasi 

yang diperkirakan dari sampel. Untuk itu, dengan standar error of Mean tertentu dan 

pada tingkat kepercayaan 95% (SPSS sebagian besar menggunakan angka ini sebagai 

stanadar), rata-rata populasi tinggi badan menjadi: 

Rata-rata Populasi = Rata-rata ± 2 standar error of Mean  

= 170,12 ± (2 x 1,20655) cm 

= (170, 12 - 2.4131) sampai (170, 12 + 2.4131) 

= 167, 7069 cm sampai 172,5331cm 

(Angka 2 digunakan karena tingkat kepercayaan 95%) 

c. Median atau titik tengah data jika semua data diurutkan dan dibagi 2 sama besar. Angka 

median 170,20 cm menunjukkan bahwa 50% tinggi badan adalah  170,20 cm ke atas, 

dan 50%-nya  170,20 cm ke bawah. 

d. Standar Deviasi adalah 6,03276 cm dan variansinya adalah 36,394 cm. Penggunaan 

standar deviasi adalah untuk menilai dispersi rata-rata dari sampel. Untuk itu, dengan 

standar deviasi tertentu dan pada tingkat kepercayaan 95%, rata-rata tinggi badan 

menjadi: 

Rata-rata tingi badan = Rata-rata ± 2 x Standar Deviasi 

= 170,12 ± (2 x 6,03276) cm 

= 170,12 ± 12,06552 

= 158,05448 cm sampai 182.18552 cm 

Perhatikan bahwa kedua batas angka berbeda tipis dengan nilai minimum dan 

maksimum, ini artinya sebaran data adalah baik.   

e. Ukuran Skewnes adalah 0,572 cm. Untuk penilaian, nilai tersebut diubah ke angka 

rasio. Rasio kurtosis adalah = nilai kurtosis/standar error kurtosis = 0,572/0,902 = 0,63. 

Sebagai pedoman, bila rasio kurtosis berada antara -2 sampai dengan +2, maka 

distribusi data adalah normal. 

f. Ukuran kurtosis adalah 1,460 cm 

g. Data minimum adalah 159,60 cm sedangkan data maksimum adalah 186,60 cm 

h. Range data = Data maksimum – Data minimum adalah 27,00 cm 

i. Angka Persentil: 

 Rata-rata tinggi badan 10% responden di bawah 160,62 cm 

 Rata-rata tinggi badan 25% responden di bawah 167,20 cm 
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 Rata-rata tinggi badan 50% responden di bawah 170,20 cm 

 Rata-rata tinggi badan 75% responden di bawah 172,50 cm 

 Rata-rata tinggi badan 90% responden di bawah 178,62 cm 

 

Tinggi 

 Frequency Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 159.6 2 8.0 8.0 8.0 

161.3 1 4.0 4.0 12.0 

164.8 2 8.0 8.0 20.0 

167.2 2 8.0 8.0 28.0 

168.5 2 8.0 8.0 36.0 

168.9 3 12.0 12.0 48.0 

170.2 1 4.0 4.0 52.0 

170.4 3 12.0 12.0 64.0 

172.5 4 16.0 16.0 80.0 

174.5 2 8.0 8.0 88.0 

177.5 1 4.0 4.0 92.0 

180.3 1 4.0 4.0 96.0 

186.6 1 4.0 4.0 100.0 

Total 25 100.0 100.0  

 

Output bagian kedua (Tinggi) 

Output ini merupakan gambaran tinggi badan responden dalam tabel frekuensi. 

 
Gambar Histogram Hasil Analisis SPSS 

 

Output bagian ketiga (Histogram) 

Terlihat grafik data berbentuk seperti lonceng, ini artinya distribusi data adalah normal 

atau mendekati normal (pengujian secara statistik akan dibahas nanti)  
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D. Tugas 

 

1. Berikut ini adalah sampel nilai dari mid test statistika I dari sekelompok mahasiswa di 

sebuah Universitas: 

30, 35, 42, 50, 58, 66, 74, 82, 90, 98, 55, 53, 68, 71, 56, 59, 62, 71 

Dengan perhitungan matematis dan aplikasi SPSS tentukanlah: rata-rata hitung, median, 

simpangan baku (Std. Deviation), variance, kemiringan, kurtosis, range, dan percentil, serta 

gambarkan bagan histogram data tersebut. 
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PRAKTIKUM 2 

UJI PRASYARAT ANALISIS 

 

A. Tujuan 

Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan uji normalitas dan 

homogenitas data hasil penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Uji Prasyarat Analisis 

Uji persyaratan analisis diperlukan untuk mengetahui apakah analisis data untuk 

pengujian   hipotesis   dapat   dilanjutkan   atau   tidak.   Beberapa   teknik   analisis   data 

menuntut uji persyaratan analisis. Misal, analisis varian mempersyaratkan bahwa data berasal 

dari   populasi   yang   berdistribusi   normal   dan   kelompok-kelompok   yang   dibandingkan 

homogen.   Oleh   karena   itu   analisis   varian   mempersyaratkan   uji   normalitas   dan 

homogenitas data. Bagian ini akan dibahas secara singkat terkait uji normalitas dan uji 

homogenitas. 

Uji normalitas data adalah bentuk pengujian tentang kenormalan distribusi data. Tujuan 

dari uji ini adalah untuk mengetahui apakah data yang terambil merupakan data terdistribusi 

normal atau bukan. Maksud dari terdistribusi normal adalah data akan mengikuti bentuk 

distribusi normal di mana data memusat pada nilai rata-rata dan median. Uji normalitas adalah 

uji yang dilakukan untuk mengecek apakah data penelitian kita berasal dari populasi yang 

sebarannya normal. Uji ini perlu dilakukan karena semua perhitungan statistik parametrik.  

Pada dasarnya uji homogenitas dimaksudkan untuk memperlihatkan bahwa dua atau 

lebih kelompok data sampel berasal dari populasi yang memiliki variansi yang sama. Pada 

perkuliahan ini akan dikenalkan salah satu uji homogenitas yang sering digunakan dalam 

penelitian yaitu uji levene. 
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C. Aplikasi SPSS untuk Uji Normalitas 

Berikut ini disajikan data tentang pre test, motivasi belajar, dan post test hasil belajar IPA SMP 

kelas VII.  

Motivasi Pre Test Post Test 

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 

 

1. Prosedur Analisis 

a. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

b. Isikan di kolom Name “Motivasi” di baris pertama dengan decimals bernilai 2, 

“PresTest” di baris ke dua dengan decimals bernilai 2, dan PostTest di baris ke tiga 

dengan decimals bernilai 2.  

Ujilah apakah ketiga variabel di atas 

memiliki distribusi normal? Ujilah 

dengan menggunakan taraf 

signifikansi 5%! 
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c. Pilih Data View dan masukan nilai motivasi belajar, pre test, dan post test sebagai 

berikut. 

 

d. Lakukan analisis dengan menggunakan menu Analyze → Non Parametric Test → 

Legacy Dialogs → 1 Sample K-S. Masukan semua variabel ke kotak Test Variable 

List. 

 

e. Klik OK sehingga muncul hasil analisis sebagai berikut. 

One-Sample Kolmogorov-Smirnov Test 

 Motivasi PresTest PostTest 

N 30 30 30 

Normal Parametersa,b Mean 63.9000 21.6000 70.8333 

Std. Deviation 8.39684 4.77493 8.22982 

Most Extreme Differences Absolute .135 .200 .274 

Positive .135 .200 .274 

Negative -.087 -.125 -.139 

Test Statistic .135 .200 .274 

Asymp. Sig. (2-tailed) .174c .004c .000c 

a. Test distribution is Normal. 

b. Calculated from data. 

c. Lilliefors Significance Correction. 
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2. Pembacaan Hasil Analisis 

Tabel One-Sample Kolmogorov-Smirnov Testmenunjukkan hasil analisis uji normalitas 

terhadap ketiga variabel tersebut. 

Hipotesis Penelitian : 

Ho  : Sampel berdistribusi normal. 

H1  : Sampel berdistribusi tidak normal. 

Ketentuan 
Jika Asymp.Sig (2-tailed) ≥ ½ α, maka Ho diterima. 

Jika Asymp. Sig (2-tailed) < ½ α, maka Ho ditolak. 

 

Berdasarkan hasil analisis di atas diperoleh : 

1) Motivasi dengan Asymp.Sig (2-tailed = 0,174) ≥ ½ α (0,05) sehingga berdistribusi 

normal. 

2) Pre Test dengan Asymp.Sig (2-tailed = 0,004) < ½ α (0,05) sehingga berdistribusi tidak 

normal. 

Post Test dengan Asymp.Sig (2-tailed = 0,000) < ½ α (0,05) sehingga berdistribusi tidak 

normal. 

 

D. Aplikasi SPSS untuk Analisis Homogenitas 

Perhitungan uji homogenitas menggunakan software SPSS adalah dengan Uji Levene 

statistics. Cara menafsirkan uji levene ini adalah, jika nilai Levene statistic > 0,05 maka dapat 

dikatakan bahwa variasi data adalah homogen.  

Dibawah ini terdapat data Skor Tes Kemampuan Pemahaman Siswa 

Siswa Eksperimen Kontrol  Siswa Eksperimen Kontrol 

S-01 4 6  S-11 4 8 

S-02 9 4  S-12 7 5 

S-03 11 6  S-13 13 12 

S-04 13 12  S-14 16 10 

S-05 5 7  S-15 10 4 

S-06 11 14  S-16 4 5 

S-07 4 13  S-17 2 4 

S-08 5 10  S-18 19 15 

S-09 9 10  S-19 15 11 

S-10 11 13  S-20 8 10 
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Berikut adalah Langkah-langkahnya: 

a. Buka SPSS 

b. Copy data tersebut ke dalam lembar kerja SPSS letakan dalam satu kolom dan perlu diingat 

no urutnya 1-20 adalah kelas eksperimen dan 21-40 kelas kontrol, kemudian pada kolom 

kedua isi dengan “1” untuk kelas Eksperimen dan “2” untuk kelas kontrol. 

 

 

c. Buka Data View, pilih baris “kelas” dan isi kolom Value  dengan “1”, Label dengan 

“Eksperimen” kemudian klik Add, kemudian lanjutkan isi kolom Value  dengan “2”, Label 

dengan “Kontrol” kemudian klik Add dan klik OK. 

 

 

d. Lakukan pengujian homogenitas dengan uji Lavene Statistic dengan cara memilih menu : 

analyze, compare means, one-way anova. 

 

 

e. Masukan “skor” ke kotak Dependen List dan “kelas” ke kotak Factor. 
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f. Klik menu  Option dan pilih Homogenity of variance test, kemudian klik Continue. 

 

 

g. Kemudian klik Ok sehingga muncul hasil: 

 Test of Homogeneity of Variances 
skor   

Levene 

Statistic df1 df2 Sig. 

.893 1 38 .351 

 

Ketentuan 
Jika nilai Sig ≥  α, maka Ho diterima. 

Jika nilai Sig <  α, maka Ho ditolak. 

 

Kerena p-value (sig) = 0,351 > 0,05 maka data siambil dari sampel yang homogen. 
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E. Tugas 

1. Diketahui data skor 36 siswa kelas VII SMP dalam menyelesaikan soal-soal IPA di suatu 

bimbingan belajar. 
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Ujilah normalitas dari data tersebut dengan menggunakan aplikasi SPSS! 

 

2. Seorang guru IPA akan melakukan penelitian metode pembelajaran keempat kelas. 

Sebelum memberi perlakuan keempat kelas, guru tersebut ingin mengetahui homogenitas 

keempat kelas tersebut dengan nilai pretest. Nilai pretest tersebut sebagai berikut. 

Sampel A1 A2 A3 A4 

1 12 14 6 9 

2 20 15 16 14 

3 23 10 16 18 

4 10 19 20 19 

5 17 22   

Ujilah homogenitas keempat kelas tersebut dengan menggunakan aplikasi SPSS. 
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PRAKTIKUM 3 

STATISTIK PARAMETRIK I 

 

A. Tujuan 

Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan uji one sample t test dan 

independent sample t test data hasil penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. One Sample T Test dan Independent T Test 

Salah satu bagian penting dalam ilmu statistik adalah persoalan inferensi yaitu penarikan 

kesimpulan secara statistik. Dua hal pokok yang menjadi pembicaraan dalam statistik inferensi 

adalah penaksiran parameter populasi dan uji hipotesis. Teknik inferensi yang pertama 

dikembangkan adalah mengenai pembuatan sejunlah besar asumsi sifat populasi di mana 

sampel telah diambil. Teknik yang banyak digunakan pada metode-metode pengujian hipotesis 

dan penaksiran interval ini kemudian dikenal sebagai Statistik Parametrik, karena harga-harga 

populasi merupakan parameter. Ditribusi populasi atau distribusi variabel acak yang digunakan 

pada teknik inferensi ini mempunyai bentuk matematik yang diketahui, akan tetapi memuat 

beberapa parameter yang tidak diketahui.  

One Sample T Test adalah uji komparatif untuk menilai perbedaan antara nilai tertentu 

dengan rata-rata kelompok populasi. One sample t test disebut juga dengan istilah student t test 

atau uji t satu sampel oleh karena uji t di sini menggunakan satu sampel. Independent sample t 

test adalah uji dengan dua sampel. Independen T Test adalah uji komparatif atau uji beda untuk 

mengetahui adakah perbedaan mean atau rerata yang bermakna antara 2 kelompok bebas yang 

berskala data interval/rasio. Dua kelompok bebas yang dimaksud di sini adalah dua kelompok 

yang tidak berpasangan, artinya sumber data berasal dari subjek yang berbeda. Misal 

Kelompok Kelas A dan Kelompok kelas B, di mana responden dalam kelas A dan kelas B 

adalah 2 kelompok yang subjeknya berbeda.  
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C. One Sample T Test dengan SPSS 

Sebelum mengolah data dengan menggunakan SPSS, masukan dulu data kedalam SPSS. 

1. Klik Variabel View pada sebelah kiri bawah jendela SPSS. 

2. Masukan data seperti dibawah gambar dibawah ini : 

 

3. Setelah itu masukan data isi botol diatas pad Data View yang ada di kiri bawah, seperti 

jendela dibawah ini : 

 

4. Pilih Analyze untuk memulai t-test, pada sub menu pilih Compare Means kemudian 

pilih One-Sample T-Test seperti dibawah ini: 

 

5. Akan muncul jendela One Sample T-Test, pindahkan variabel botol ke test variabel 

dengan memilih variabel botol kemudian klik tanda panah ke kanan di jendela tersebut. 

Dan isikan test Value dengan T hitung yang dijadikan perbandingan. 

6. Klik Option pada jendela One Sample T-Test kemudian muncul jendela berikutnya. 

Isikan derajat keyakinan sebesar 95%  (α = 55) 
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7. Klik Continue kemudian Ok akan muncul jendela hasil yang menampilkan text dan 

tabel seperti dibawah ini : 

 

T-Test 

[DataSet0]  

One-Sample Statistics 

 N Mean Std. Deviation Std. Error Mean 

B

o
t

o

l 

20 100.45 2.544 .569 

 

One-Sample Test 

 Test Value = 100 

T df Sig. (2-tailed) Mean Difference 95% Confidence Interval of the Difference 

Lower Upper 

B

o
t

o

l 

.791 19 .439 .450 -.74 1.64 

 

8. Kesimpulan 

Dari output kedua diperoleh nilai t hitung SPSS = 0,791. Sedangkan nilai -𝑡𝛼 2⁄  dan 𝑡𝛼 2⁄  

adalah -2,093 dan 2,093. Jika dibandingkan, maka t hitung SPSS berada di antara 

angka-angka t tabel, sehingga Ho diterima. Karena Sig. (2-tailed) > 0,05 maka H0 

diterima. 

Oleh karena dapat diambil keputusan bahwa dengan tingkat kepercayaan 95%, secara 

signifikan hasil pengujian tidak berbeda dengan apa yang diklaim oleh perusahaan 

pembuat mesin pengisi botol. 
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D. Independent sample t test dengan SPSS 

Berikut ini disajikan data IPK mahasiswa kelas A yang (pembelajaran ceramah) dengan Kelas 

B (pembelajaran berbasis media komputer) dengan pembelajaran inkuiri. 

Nilai IPA 

Kelas A Kelas B 

3.12 3.29 

3.33 2.89 

3.40 3.48 

3.21 3.75 

2.98 3.33 

3.02 2.87 

3.66 3.27 

3.51 3.87 

 3.23 

 3.12 

 3.04 

 

Ujilah apakah kedua kelas memiliki varian yang sama? 

Ujilah apakah ada perbedaan IPK antara mahasiswa kelas A dan kelas B? Jika ada 

perbedaan, manakah yang memiliki IPK lebh tinggi?  

(Gunakan taraf signifikansi 5%) 

Prosedur Analisi 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Kelas” di baris pertama dengan decimals bernilai 0, dan “IPK” 

di baris ke dua dengan decimals bernilai 2.  

 

3. Pilih Data View di samping Variable View dan masukan data IPK  dengan indeks 1 

untuk kelas A dan indeks 2 untuk kelas B serta masukan semua nilainya. 

 

4. Pilih menu Analyze → Compare Mean → Independent-Samples T Test. 
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5. Masukan variabel Nilai ke Test Variable(s) dan Kelas ke Grouping Variable. 

 

6. Klik tombol Define Groups dan isikan 1 di Group 1 dan 2 di Group 2 dan klik tombol 

continue.  

 

7. Klik OK sehingga muncul hasil sebagai berikut. 
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Output SPSS untuk Independent Samples T Test. 
 

 

Independent Samples Test 

 

Levene's Test for Equality of 

Variances t-test for Equality of Means 

F Sig. t Df 

Sig. (2-

tailed) 

Mean 

Difference 

Std. Error 

Difference 

95% Confidence Interval of the 

Difference 

Lower Upper 

Nilai Equal variances assumed 2.835 .111 -5.845 17 .000 -.77670 .13288 -1.05705 -.49636 

Equal variances not assumed   -5.261 9.369 .000 -.77670 .14763 -1.10868 -.44473 

 

 

Group Statistics 

 
Kelas N Mean Std. Deviation Std. Error Mean 

Nilai 1 8 2.9788 .38632 .13658 

2 11 3.7555 .18587 .05604 
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8. Pembacaan hasil analisis dan kesimpulan. 

a. Tabel Independent Samples Test menampilkan uji varian kedua kelompok dan 

perbedaan.  

F test digunakan untuk menguji asumsi dasar dari t test bahwa varian kedua kelompok 

sama. 

Hipotesis Penelitian : 

Ho : kedua kelompok memiliki varian yang sama (homogen). 

H1 : kedua kelompok memiliki varian yang tidak sama  (tidak homogen). 

Ketentuan 

Jika F hitung < F table, maka Ho diterima. 

Jika F hitung > F table, maka Ho ditolak. 

Atau 

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

 

Nilai Sig (0,111) > α (0,05), maka Ho diterima. Jadi kedua kelompok memiliki varian 

yang sama  (homogen). 

 

Uji selanjutnya memakai nilai pada baris bagian atas (equal variances assumed), namun 

apabila pada perhitungan Sig < α maka memakai nilai baris yang bawah. 

Hipotesis Penelitian : 

Ho  : jenis pembelajaran tidak berpengaruh terhadap IPK mahasiswa. 

H1   :  jenis pembelajaran berpengaruh terhadap IPK mahasiswa. 

Ketentuan 

Jika t hitung < t table, maka Ho diterima. 

Jika t hitung > t table, maka Ho ditolak. 

Atau 

Jika Sig (2-tailed) > ½ α, maka Ho diterima. 

Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 

 

Nilai t hitung kecil dan nilai Sig (2-tailed = 0,000) < ½ α (0,05) maka Ho ditolak. Jadi 

jenis pembelajaran yang digunakan dalam pembelajaran berpengaruh pada IPK 

mahasiswa. 
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E. Tugas 

1. Diberikan data nilai hasil belajar kedua kelas A dan B. Kelas A merupakan kelas kontrol 

dengan pembelajaran ceramah dan kelas B merupakan kelas eksperimen dengan 

pembelajaran inkuiri sebagai berikut. 

Sampel A B 

1 80 73 

2 78 81 

3 78 77 

4 81 79 

5 87 64 

6 67 89 

7 76 72 

8 68 82 

9 75 76 

10 74 78 

11 81 75 

12 77 87 

13 79 67 

14 64 76 

15 89 73 

 

Ujilah apakah kedua kelas terdapat perbedaan dengan SPSS 

 

2. Diketahui data skor 30 siswa dalam menyelesaikan soal-soal matematika pada try out di 

suatu bimbingan belajar 

72 48 66 62 76 58 78 32 74 41 47 

57 80 52 54 81 66 70 85 64 70 60 

65 88 43 37 68 55 39 35    

 

Ujilah dengan one sample t test dengan SPSS untuk mengetahui perbedaan dengan hasil 

try out ke,arin jika tahun kemarin nilai rata-ratanya adalah 65. 
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PRAKTIKUM 4 

STATISTIK PARAMETRIK II 

 

 

A. Tujuan 

Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan uji paired t test dan Anova 

data hasil penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Paired T Test dan Anova 

Analisis paired-sample t-test merupakan prosedur yang digunakan untuk 

membandingkan rata-rata dua variabel dalam satu group. Analisis ini digunakan untuk 

melakukan pengujian terhadap satu sampel yang mendapatkan sata treatment yang kemudian 

akan dibandingkan rata-rata dari sampel tersebut antara sebelum dan sesudah treatment.  

Analisis varians (analysis of variance) atau ANOVA adalah suatu metode analisis 

statistika yang termasuk ke dalam cabang statistika inferensi. Uji dalam anova menggunakan 

uji F karena dipakai untuk pengujian lebih dari 2 sampel. Dalam praktik, analisis varians dapat 

merupakan uji hipotesis (lebih sering dipakai) maupunpendugaan (estimation, khususnya di 

bidang genetika terapan). 

 

C. Paired T Test dengan SPSS 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “PreTest” di baris pertama dengan decimals bernilai 2, dan 

“PostTest” di baris ke dua dengan decimals bernilai 2.  

 

3. Pilih Data View dan masukan data pre test dan post test sebagai berikut. 
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4. Pilih menu Analyze → Compare Mean → Paired-Samples T Test. 

 

 

5. Masukan variabel PreTest dan PostTest ke kotak Paired Variables. 

 

 

6. Klik OK sehingga muncul hasil sebagai berikut. 
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Output SPSS untuk Paired Samples T Test. 
Paired Samples Statistics 

 Mean N Std. Deviation Std. Error Mean 

Pair 1 PreTest 40.4000 10 6.00370 1.89854 

PostTest 72.0000 10 6.68331 2.11345 

 
Paired Samples Correlations 

 N Correlation Sig. 

Pair 1 PreTest & PostTest 10 .817 .004 

 
Paired Samples Test 

 

Paired Differences 

t df Sig. (2-tailed) Mean Std. Deviation Std. Error Mean 

95% Confidence Interval of the 

Difference 

Lower Upper 

Pair 1 PreTest – PostTest -31.60000 3.89301 1.23108 -34.38489 -28.81511 -25.669 9 .000 
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7. Pembacaan Hasil Analisis 

a. Tabel Paired Samples Correlations menampilkan uji korelasi nilai pre test dan post 

test. 

Hipotesis Penelitian: 

Ho  : Tidak ada hubungan antara pre test dan post test dengan pembelajaran 

inkuiri. 

H1  : Ada hubungan antara pre test dan post test dengan pembelajaran inkuiri. 

Ketentuan penerimaan/penolakan hipotesis sebagai berikut. 

thitung < ttabel, maka Ho diterima 

thitung > ttabel, maka Ho ditolak 

Atau  

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Kesimpulan: 

Nilai Sig (0,004) < α (0,05), maka Ho ditolak. Jadi ada hubungan antara pre test dan 

post test dengan pembelajaran inkuiri dengan tingkat hubungan/korelasi cukup besar, 

yaitu 0,817. 

b. Tabel Paired Samples Test menampilkan uji beda nilai pre test dan post test sesudah 

perlakuan/pembelajaran inkuiri. 

Hipotesis Penelitian: 

Ho  :  Tidak ada perbedaan antara pre test dan post test dengan pembelajaran 

inkuiri. 

H1  : Ada perbedaan antara pre test dan post test dengan pembelajaran inkuiri. 

Ketentuan penerimaan/penolakan hipotesis sebagai berikut. 

thitung < ttabel, maka Ho diterima 

thitung > ttabel, maka Ho ditolak 

Atau 

Jika Sig (2-tailed) >½ α, maka Ho diterima. 

Jika Sig (2-tailed) <½ α, maka Ho ditolak. 

Kesimpulan 

Nilai Sig (2-tailed = 0,000) <½ α (0,025), maka Ho ditolak. Jadi ada perbedaan nilai 

pre test dan post test sesudah perlakuan/pembelajaran inkuiri. Dengan kata lain 

pembelajaran inkuiri berpengaruh terhadap hasil post test. 
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D. Anova dengan SPSS 

Berikut ini disajikan data skore TOEFL Mahasiswa Pendidikan IPA yang mengikuti kursus 

bahasa Inggris. 

Sampel 
Lama Kursus 

3 bulan 6 bulan 9 bulan 

1 423 444 478 

2 410 459 480 

3 421 440 494 

4 428 435 507 

5 404 468 459 

 

Ujilah apakah ada perbedaan antara lama kursus terhadap skore TOEFL? (Gunakan taraf 

signifikansi 5%). 

Analisis Perhitungan dengan SPSS. 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “LamaKursus” di baris pertama dengan decimals bernilai 0, dan 

“SkoreToefl” di baris ke dua dengan decimals bernilai 2.  

 

 

3. Pilih Data View dan masukan data lama kursus dan skore Toefl sebagai berikut.   
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4. Pilih menu Analyze → Compare Mean → One Way Anova. 

 

 

5. Masukan variabel SkoreToefl ke kotak Dependent List, dan LamaKursus ke kotak 

Faktor. 

 

 

6. Klik tombol Post Hoc → LSD → Continue. 

 

 

7. Klik tombol Options → Descriptive → Homogeneity of Variances Test → Continue. 
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8. Klik OK sehingga muncul hasil sebagai berikut. 
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Output SPSS untuk Anova. 
Descriptives 

SkoreToefl   

 N Mean Std. Deviation Std. Error 

95% Confidence Interval for Mean 

Minimum Maximum Lower Bound Upper Bound 

3 5 417.2000 9.88433 4.42041 404.9270 429.4730 404.00 428.00 

6 5 449.2000 13.80942 6.17576 432.0533 466.3467 435.00 468.00 

9 5 483.6000 18.06378 8.07837 461.1709 506.0291 459.00 507.00 

Total 15 450.0000 31.03684 8.01368 432.8124 467.1876 404.00 507.00 

 

Test of Homogeneity of Variances 
SkoreToefl   

Levene Statistic df1 df2 Sig. 

.786 2 12 .478 

 

ANOVA 
SkoreToefl   

 Sum of Squares Df Mean Square F Sig. 

Between Groups 11027.200 2 5513.600 26.909 .000 

Within Groups 2458.800 12 204.900   

Total 13486.000 14    

 

Multiple Comparisons 
Dependent Variable:   SkoreToefl   

LSD   

(I) LamaKursus (J) LamaKursus 

Mean Difference 

(I-J) Std. Error Sig. 

95% Confidence Interval 

Lower Bound Upper Bound 

3 6 -32.00000* 9.05318 .004 -51.7252 -12.2748 

9 -66.40000* 9.05318 .000 -86.1252 -46.6748 

6 3 32.00000* 9.05318 .004 12.2748 51.7252 

9 -34.40000* 9.05318 .003 -54.1252 -14.6748 

9 3 66.40000* 9.05318 .000 46.6748 86.1252 

6 34.40000* 9.05318 .003 14.6748 54.1252 

*. The mean difference is significant at the 0.05 level. 
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9. Pembacaan Hasil Analisis 

a. Tabel Descriptives menunjukan hasil analisis statistik deskriptifnya seperti rata per 

kelompok, standar deviasi, standar error, minimum dan maksimum. 

b. Tabel Test of Homogeneity of Variances menunjukan hasil uji homogenitas varians 

sebagai prasyarat untuk dapat menggunakan ANOVA. 

Hipotesis Penelitian: 

Ho : Ketiga kelompok memiliki nilai varian yang sama. 

H1 : Ketiga kelompok memiliki nilai varian yang tidak sama. 

Ketentuan penerimaan/penolakan: 

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Kesimpulan: 

Hasil pengujian ditemukan bahwa F hitung = 0,786 dengan sig = 0,478. Oleh karena 

nilai sig > α (0,05) maka dapat disimpulkan bahwa ketiga kelompok memiliki nilai 

varian yang sama atau dengan kata lainvarians antar kelompok bersifat 

homogen.Dengan demikian prasyarat untuk dapat menggunakan ANOVA terpenuhi. 

c. Tabel ANOVAmenunjukan hasil uji beda rata-rata secara keseluruhan. 

Hipotesis Penelitian : 

Ho : Ketiga kelompok memiliki rata-rata skore Toefl yang sama. 

H1 :Ketiga kelompokmemilikirata-rata skore Toeflyang berbeda. 

Ketentuan penerimaan/penolakan : 

Jika F hitung < F tabel, maka Ho diterima. 

Jika F hitung > F tabel, maka Ho ditolak. 

Atau  

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Hasil analisis ditemukan harga F hitung sebesar 26,909 dengan sig = 0,000. Oleh karena 

nilai sig < 0,05 maka Ho ditolak sehingga dapat disimpulkan ada perbedaan rata-rata 

skore Toefl antara mahasiswa yang mengambil kursus tiga bulan, enam bulan, dan 

Sembilan bulan.  

Keterangan: jika hasil pengujiannya signifikan maka dilanjutkan ke uji post hoc, tetapi 

jika tidak signifikan pengujian berhenti sampai di sini). 



 

34 Statistik Parametrik II 

 

d. Tabel Multiple Comparison smenunjukan hasil uji lanjut untuk mengetahui perbedaan 

antar kelompok secara spesifik sekaligus untuk mengetahui mana di antara ketiga 

kelompok tersebut yang skore Toeflnya paling tinggi. 

Hipotesis Penelitian: 

Ho : Kedua kelompok memiliki rata-rata skore Toefl yang sama. 

H1 : Kedua kelompok memiliki rata-rata skore Toefl yang tidak sama. 

Ketentuan penerimaan/penolakan: 

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Misalnya untuk melihat perbedaan skore Toefl antara mahasiswa yang kursus tiga 

bulan dan enam bulan diperoleh nilai sig = 0,004, Oleh karena nilai sig < 0,05 dapat 

disimpulkan bahwa ada perbedaan skore Toefl antara mahasiswa yang kursus tiga 

bulan dan enam bulan. Dalam hal ini skore Toefl mahasiswa yang kursus enam bulan 

lebih tinggi dari pada yang kursus tiga bulan. Dengan kata lain lama kursus 

berpengaruh terhadap peningkatan skore Toefl mahasiswa. 
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E. Tugas 

1. Uji anova satu arah akan digunakan untuk mengetahui adakah hubungan antara tingkat 

stress mahasiswa pada program studi teknik fisika. Tingkat stress diukur pada skala 1-10. 

Skala 1 hingga 3 menunjukkan mahasiswa cukup stress. Skala 4 sampai 6 menunjukkan 

mahasiswa dalam keadaan stress dan skala 7 keatas menunjukkan mahasiswa sangat stress. 

Pengamatan dilakukan dengan menggunakan metode pengumpulan data yaitu kuisioner 

yang disebarkan pada 75 responden. 

1 Tahun 2 Tahun 3 Tahun 

4 2 1 4 1 2 4 1 2 8 6 6 5 9 5 

6 2 2 7 4 2 5 9 1 8 2 8 1 9 6 

2 1 3 9 5 3 6 8 1 7 1 1 3 2 7 

8 7 5 5 4 4 7 4 4 7 9 4 2 1 3 

8 5 2 4 7 5 8 7 7 7 8 8 5 4 4 

 

Gunakan SPSS untuk analisis uji Anova untuk mengetahui apakah terdapat hubungan 

antara tahun studi terhadap tingkat stress mahasiswa teknik fisika tersebut. Gunakan taraf 

signifikansi 5%. 

 

2. Seorang guru ingin menguji efektifitas model pembelajaran tatistik dengan studi kasus. 

Maka dilakukan pre test dan post test dari 21 siswanya. Berikut data pretest dan post test. 

Ujilah data tersebut dengan uji t berpasangan (paired t test) dengan SPSS dan perhitungan 

biasa, gunakan α = 5% (Anggap data berdistribusi normal dan homogen). 

Pre Test Post Test  Pre Test Post Test 

76 79 75 75 

83 89 85 80 

75 70 76 79 

76 75 76 76 

60 79 45 80 

66 80 79 75 

77 89 75 89 

90 90 79 85 

75 83 68 70 

65 70 80 80 

70 75   
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PRAKTIKUM 5 

STATISTIK NONPARAMETRIK I 

 

A. Tujuan 

Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan uji Chi Kuadrat dan uji Mann 

Whitney data hasil penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Uji Chi Kuadrat dan Uji Mann Whitney 

Pengujian dengan statistik non parametrik merupakan pengujian yang tidak 

membutuhkan asumsi mengenai bentuk distribusi sampling statistika dan atau bentuk distribusi 

populasinya. Pengujian non parametrik tidak menuntut: sampel yang diambil harus 

berdistribusi normal dan angka-angka sampel merupakan ukuran-ukuran tingkat taraf tinggi. 

Metode statistik nonparametrik merupakan metode statistik yang dapat digunakan dengan 

mengabaikan segala asumsi yang melandasi metode statistik parametrik, terutama yang 

berkaitan dengan distribusi normal. Uji statistik non parametrik I yang akan dipelajari pada 

bagian ini yaitu: Uji Chi Kuadrat analog dengan One Sample Test dan Uji Mann Whitney analog 

dengan Two Independent Samples Test. 

Prosedur uji Chi Kuadrat dilakukan dengan mentabulasi suatu variabel ke dalam kategori-

kategori dan melakukan uji hipotesis bahwa frekuensi yang diamati tidak berbeda dengan nilai 

yang diharapkan. Metode chi-kuadrat (x2) digunakan untuk mengadakan pendekatan 

(mengestimate) dari beberapa faktor atau mengevaluasi frekuensi yang diselidiki atau frekuensi 

hasil observasi (fo) dengan frekuensi yang diharapkan (fe) dari sampel apakah terdapat 

hubungan atau perbedaan yang signifikan atau tidak. Untuk mengatasi permasalahan seperti 

ini, maka perlu diadakan teknik pengujian yang dinamakan pengujian x2. 

Uji Two Independent Sample pada hakikatnya sama dengan uji Independent Sample T 

Test dengan persyaratan yang lebih longgar. Ada dua kelonggaran prasyarat yaitu: mampu 

digunakan untuk tipe data ordinal dan tidak mensyaratkan distribusi tertentu (normal). Uji 

Mann-Whitney/Wilcoxon merupakan alternatif bagi uji-t. Uji Mann Whitney digunakan untuk 

membandingkan dua mean populasi yang berasal dari populasi yang sama. Uji Mann-Whitney 

juga digunakan untuk menguji apakah dua mean populasi sama atau tidak. 
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C. Uji Chi Kuadrat dengan Aplikasi SPSS 

Kepala Dinas Pendidikan di Kuala Hajir melakukan penelitian Gerakan Disiplin Sekolah 

(GDS) siswa tingkat SMP yaitu SMP 1,  SMP 2, dan SMP 3. Sampel diambil sebanyak 725 

siswa yang menyebar SMP1 = 275 siswa, SMP 2 = 250 orang, dan SMP 3 = 200 orang. 

Frekuensi Observasi dari 725 siswa tersebut dikelompokkan ke dalam tiga level disiplin (tinggi, 

sedang, dan rendah). 

Tabel Hasil Pelaksanaan GDS siswa SMP di Kuala Hajir. 

Siswa SMP 
Pelaksanaan GDN 

Total 
Tinggi (100-85) Sedang (84-66) Rendah (65-0) 

SMP 1 150 75 50 275 

SMP 2 75 150 25 250 

SMP 3 150 25 25 200 

Jumlah 375 250 100 725 

 

Langkah 1: memberi bobot data 

1. Membuka aplikasi SPSS, pada ”Variable View” isikan pada kolom Name: Tingkat dan 

Jumlah sebagaimana gambar berikut. 

 

2. Pada ”Data View”, masukkan data yang akan dianalisis sebagaimana gambar berikut.  

 

Keterangan: 1 = Tinggi, 2 = Sedang, dan 3 =Rendah 

3. Klik Data => Weight Cases pada menu, sehingga muncul kotak dialog sebagai gambar 

berikut. 
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4. Pilih ”Weight cases by” dan masukkan ”Jumlah” pada kotak ”Frequency Variable”, 

kemudian klik OK. 

 

 

Langkah 2: analisis Chi Square 

5. Klik Analyze => Nonparametric Test => Legacy Dialogs => Chi Square, sehingga muncul 

kotak dialog sebagaimana gambar berikut. 

 

6. Masukkan variabel ”Tingkat” pada kotak ”Test Variable List”. Secara default Get from 

data ada kotak Expected Range dan All categories equal pada kotak Expected Values akan 

terpilih. 

 

7. Klik OK. 

Hasil analisis sebagai berikut. 
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Tingkat 

 Observed N Expected N Residual 

1 375 241.7 133.3 

2 250 241.7 8.3 

3 100 241.7 -141.7 

Total 725   

 
Test Statistics 

 Tingkat 

Chi-Square 156.897a 

Df 2 

Asymp. Sig. .000 

a. 0 cells (0.0%) have 

expected frequencies less than 

5. The minimum expected cell 

frequency is 241.7. 

Keterangan: 

Hasil analisis Chi Square Test:  

Ha : Ada perbedaan yang signifikan antara siswa SMP 1, SMP 2, dan SMP 3 dalam 

pelaksanaan GDS. 

Ho : Tidak ada perbedaan yang signifikan antara siswa SMP 1, SMP 2, dan SMP 3 dalam 

pelaksanaan GDS 

 

Hasil Analisis SPSS Keterangan 

Jika X2
hitung <  X2

tabel Ho diterima 

Jika X2
hitung > X2

tabel Ho ditolak 

Atau  

Jika Asymp Sig > α Ho diterima 

Jika Asymp Sig < α Ho ditolak 

 

Berdasarkan hasil analisis, tingkat kepercayaan 95% (α = 5%), df(k-1) = 2 

Asymp Sig = 0.000 < α , sehingga Ho ditolak. 

Kesimpulan: Ada perbedaan yang signifikan antara siswa SMP 1, SMP 2, dan SMP 3 dalam 

pelaksanaan GDS. 
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D. Uji Mann Whitney dengan SPSS 

Seorang peneliti ingin mengetahui, apakah terdapat perbedaan nilai tes siswa yang diajar 

dengan metoda A  dan yang diajar dengan metoda B. Berikut data nilai siswa tersebut. Gunakan 

 = 5 %. 

Nilai tes siswa yang diajar dengan metoda A : 56, 70, 57, 58, 45, 37, 69, 67, 60     

Nilai tes siswa yang diajar dengan metoda B : 75, 59, 27, 91 

Penyelesaian dengan Aplikasi SPSS 

1. Membuka aplikasi SPSS, pada ”Variable View” isikan pada kolom Name: metode dan 

rangking sebagaimana gambar berikut. 

 

2. Pada ”Data View”, masukkan data yang akan dianalisis sebagaimana gambar berikut. 

 

3. Klik Analyze => Nonparametric Test => Legacy Dialogs => 2 Independent Samples, 

maka muncul kotak dialog sebagai berikut. 

 

4. Masukkan variabel “rangking” pada kotak “Test Variable List”, masukkan variabel 

“metode” pada kotak “Grouping Variable” dan pilih uji Mann Whitney U pada kotak Test 

Type. 
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5. Klik Define Groups, masukkan nilai variabel metode pada kotak Group 1 dan 2. 

 

6. Klik Continue, sehingga kembali ke kotak dialog Two Independent Samples Test. 

 

7. Klik OK 

Hasil analisis dengan SPSS sebagai berikut. 

Ranks 

 metode N Mean Rank Sum of Ranks 

rangking 1.00 9 7.22 65.00 

2.00 4 6.50 26.00 

Total 13   

 
Test Statisticsa 

 rangking 

Mann-Whitney U 16.000 

Wilcoxon W 26.000 

Z -.309 

Asymp. Sig. (2-tailed) .757 

Exact Sig. [2*(1-tailed Sig.)] .825b 

a. Grouping Variable: metode 

b. Not corrected for ties. 
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Keterangan:  

H0 : tidak ada perbedaan nilai tes siswa yang diajar dengan metoda A  dan yang diajar 

dengan metoda B.  

Ha : ada perbedaan nilai tes siswa yang diajar dengan metoda A  dan yang diajar dengan 

metoda B. 

Hasil Analisis SPSS Keterangan 

Jika Asymp Sig (2-tailed) > α Ho diterima 

Jika Asymp Sig (2-tailed) < α Ho ditolak 

 

Berdasarkan hasil analisis, tingkat kepercayaan 95% (α = 5%) 

Asymp Sig (2-tailed)  = 0.757 > α = 0.050, sehingga Ho diterima. 

Kesimpulan: tidak ada beda nilai tes siswa yang diajar dengan metoda A  dan yang diajar 

dengan metoda B. 

 

E. Tugas 

1. Kepala Sekolah di SMP X Maju Prestasi melakukan penelitian untuk mengetahui apakah 

ada perbedaan/tidak dalam tingkat kedisiplinan siswa di sekolahnya dalam bentuk Gerakan 

Disiplin Sekolah (GDS) yaitu SMP Kelas VI,  Kelas VII, dan Kelas IX. Sampel diambil 

sebanyak 625 siswa yang menyebar Kelas VI = 225 siswa, Kelas VII = 225 orang, dan 

Kelas IX = 175 orang. Frekuensi Observasi dari 625 siswa tersebut dikelompokkan ke 

dalam tiga level disiplin (tinggi, sedang, dan rendah). 

Pelaksanaan GDS siswa SMP X Maju Prestasi 

Siswa SMP 

Pelaksanaan GDS 

Total Tinggi 

(100-85) 

Sedang 

(84-66) 

Rendah 

(65-0) 

Kelas VI 100 75 50 225 

Kelas VII 50 150 25 225 

Kelas IX 125 25 25 175 

Jumlah 375 250 100 725 

 

2. Seorang peneliti ingin mengetahui, apakah terdapat perbedaan nilai tes siswa yang diajar 

dengan metoda A  dan yang diajar dengan metoda B. Berikut data nilai siswa tersebut. 

Gunakan  = 5 %. 

Nilai tes siswa yang diajar dengan metoda A : 76, 50, 87, 78, 55, 67, 63, 67, 60     

Nilai tes siswa yang diajar dengan metoda B : 45, 59, 37, 81, 65 
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PRAKTIKUM 6 

STATISTIK NONPARAMETRIK II 

 

A. Tujuan 

Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan uji Two Related Samples Test 

dan K-Independent Samples Test data hasil penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Two Related Samples Test (Uji Wilcoxon) dan K-Independent Samples Test 

Uji Two Related Samples pada hakikatnya sama dengan uji Paired Sample T Test dengan 

persyaratan yang lebih longgar. Kelonggaran tersebut yaitu: mampu digunakan baik untuk tipe 

data ordinal maupun scale, dan tidak mensyaratkan distribusi tertentu (normal). Uji ini 

digunakan untuk menguji perbedaan nilai variabel berpasangan atau berhubungan. Uji Two 

Related Samples yang akan dipelajari adalah Uji Wilcoxon. Uji Wilcoxon digunakan jika besar 

maupun arah perbedaan diperhatikan dalam menentukan apakah ada perbedaan nyata antara 

data pasangan yang diambil dari satu sampel atau sampel yang berhubungan.  

K-Independent Samples Test di sebut juga uji Kuskal-Wallis pada hakikatnya sama 

dengan uji Anova dengan prasyarat yang lebih longgar. Kelonggaran prasyarat tersebut yaitu: 

mampu digunakan untuk data ordinal, dan distribusi variabel yang di uji tidak harus normal. 

Uji ini digunakan untuk menetapkan apakah nilai variabel tertentu berbeda pada dua atau lebih 

kelompok.  
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C. Two Related Samples Test (Uji Wilcoxon) dengan SPSS 

Seorang guru mengadakan penelitian pengaruh model pembelajaran terhadap skor benar 

dari 10 siswa sebagai berikut. Ujilah apakah ada perbedaan pengaruh model pembelajaran 

terhadap skor benar dari siswa tersebut. Diketahui data tidak berdistribusi normal. 

No Sebelum Sesudah 

1. 1 4 

2. 3 4 

3. 2 3 

4. 1 2 

5. 2 5 

6. 4 2 

7. 1 1 

8. 4 3 

9. 2 3 

10. 3 4 

 

Penyelesaian dengan Aplikasi SPSS 

1. Membuka aplikasi SPSS, pada ”Variable View” isikan pada kolom Name: sebelum dan 

sesudah sebagaimana gambar berikut. 

 

2. Pada ”Data View”, masukkan data yang akan dianalisis sebagaimana gambar berikut. 

 

3. Klik Analyze => Nonparametric Test => Legacy Dialogs => 2-Related Samples 

sebagaimana gambar berikut. 
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4. Blok variabel “sebelum dan sesudah” hingga aktif dan pindahkan ke kotak Test Pair(s) List 

dengan klik tombol panah sehingga muncul sebelum – sesudah pada kotak tersebut. Pada 

kotak Test Type, pilih uji Wilcoxon. 

 

 

5. Klik OK. 

Hasil analisis dengan SPSS sebagai berikut. 

Ranks 

 N Mean Rank Sum of Ranks 

sesudah - sebelum Negative Ranks 2a 5.25 10.50 

Positive Ranks 7b 4.93 34.50 

Ties 1c   
Total 10   

a. sesudah < sebelum 
b. sesudah > sebelum 
c. sesudah = sebelum 

Test Statisticsa 

 
sesudah - 
sebelum 

Z -1.469b 
Asymp. Sig. (2-tailed) .142 

a. Wilcoxon Signed Ranks Test 
b. Based on negative ranks. 

Keterangan:  
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H0 : tidak ada perbedaan/ pengaruh model pembelajaran terhadap skor siswa. Ha  : 

ada perbedaan/ pengaruh model pembelajaran terhadap skor siswa. 

Hasil Analisis SPSS Keterangan 

Jika Asymp Sig (2-tailed) < α (0.025) Ho diterima 

Jika Asymp Sig (2-tailed) > α (0.025) Ho ditolak 

 

Berdasarkan hasil analisis, tingkat kepercayaan 95% (α = 5%) 

Asymp Sig (2-tailed)  = 0.142 > α = 0.025, sehingga Ho ditolak. 

Kesimpulan: ada perbedaan/ pengaruh model pembelajaran terhadap skor siswa. 

 

D. K-Independent Samples Test dengan SPSS 

Seorang  guru IPA melakukan penelitian kelas. Guru tersebut  ingin  mengetahui  apakah  

ada  perbedaan prestasi belajar siswa yang diajar dengan strategi A, strategi B,  dan strategi C. 

Setelah  diadakan  perlakuan  hasilnya  adalah  sebagai berikut. 

Strategi A Strategi B Strategi C 

36 50 62 

45 50 90 

59 40 45 

61 77 70 

 60 90 

 45  

 

Ujilah dengan uji statistik untuk mengetahui ada atau tidak perbedaan prestasi belajar  antara 

siswa yang diajar stratehi A, B, dan C. Data tidak berdistribusi normal,  = 5 %. 

Penyelesaian dengan Aplikasi SPSS 

1. Membuka aplikasi SPSS, pada ”Variable View” isikan pada kolom Name: strategi dan 

prestasi sebagaimana gambar berikut. 

 

 

2. Pada ”Data View”, masukkan data yang akan dianalisis sebagaimana gambar berikut. 
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3. Klik Analyze => Nonparametric Test => Legacy Dialogs => K-Independent Samples 

sebagaimana gambar berikut. 

 

4. Masukkan variabel prestasi pada kotak Test Variable List, masukkan variabel strategi pada 

kotak Grouping Variable dan pilih Meidan 

 

 

5. Klik Define Range, masukkan rentang nilai variabel strategi pada kotak Minimum (1) dan 

Maximum (3). 
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6. Klik Continue, sehingga kembali ke kotak dialog Test for Several Independent Samples. 

7. Klik OK. 

Hasil analisis dengan SPSS sebagai berikut. 
Frequencies 

 
strategi 

1.00 2.00 3.00 

Prestasi > Median 1 2 4 

<= Median 3 4 1 

 
Test Statisticsa 

 Prestasi 

N 15 
Median 59.0000 
Chi-Square 3.415b 
Df 2 
Asymp. Sig. .181 

a. Grouping Variable: 
strategi 
b. 6 cells (100.0%) have 
expected frequencies less 
than 5. The minimum 
expected cell frequency is 
1.9. 

 

Keterangan: 

Hipotesis 

Ho : tidak ada perbedaan prestasi belajar antara siswa yang diajar strategi A, B, dan C 

H1 : ada perbedaan prestasi belajar antara siswa yang diajar strategi A, B, dan C 

Hasil Analisis SPSS Keterangan 

Jika Asymp Sig > α  Ho diterima 

Jika Asymp Sig < α  Ho ditolak 

 

Berdasarkan hasil analisis, tingkat kepercayaan 95% (α = 5%) 

Asymp Sig  = 0.181 > α = 0.05, sehingga Ho diterima. 
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Kesimpulan: tidak ada perbedaan prestasi belajar  antara siswa yang diajar strategi A, B, dan 

C. 

 

E. Tugas 

1. Seorang  guru IPA melakukan penelitian kelas untuk  mengetahui  ada/tidak  perbedaan 

prestasi belajar siswa yang diajar dengan metode A, metode B,  dan metode C dengan data  

sebagai berikut. 

Strategi A Strategi B Strategi C 

46 60 52 

55 60 80 

69 50 35 

71 87 60 

59 70 80 

 55  

Ujilah dengan uji statistik untuk mengetahui ada atau tidak perbedaan prestasi belajar  

antara siswa yang diajar stratehi A, B, dan C. Data tidak berdistribusi normal,  = 5 %. 

 

2. Seorang guru mengadakan penelitian pengaruh model pembelajaran terhadap skor benar 

dari 15 siswa sebagai berikut. Ujilah apakah ada perbedaan pengaruh model pembelajaran 

terhadap skor benar dari siswa tersebut. Diketahui data tidak berdistribusi normal. 

No Pretest Posttest 

1. 1 4 

2. 3 4 

3. 2 3 

4. 1 2 

5. 2 5 

6. 4 2 

7. 1 1 

8. 4 3 

9. 2 3 

10. 3 4 

11. 4 1 

12. 2 3 

13. 3 3 

14. 3 4 

15. 3 5 
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PRAKTIKUM 7 

UJI KORELASI 

 

A. Tujuan 

 Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan uji korelasi data hasil 

penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Uji Korelasi 

Analisis korelasi merupakan metode statistik yang digunakan untuk mengukur besarnya 

hubungan linier antara dua variabel atau lebih. Nilai korelasi populasi (ρ) berkisar pada interval 

-1 ≤ ρ ≤ 1. Jika korelasi bernilai positif, maka hubungan antara dua variabel bersifat searah. 

Sebaliknya, jika korelasi bernilai negatif, maka hubungan antara dua variabel bersifat 

berlawanan arah. Misalkan korelasi sampel antara variabel X dan Y (rX,Y) bernilai positif 

mengartikan bahwa jika nilai X naik maka nilai Y juga naik, sedangkan jika nilai X turun maka 

nilai Y juga turun. Misalkan korelasi sampel antara variabel X dan Y (rX,Y) bernilai negatif 

mengartikan bahwa jika nilai X naik maka nilai Y juga turun, sedangkan jika nilai X turun 

maka nilai Y juga naik.  

Tabel. Koefisien Korelasi dan Interpretasinya* 

Nilai Korelasi Sampel (r) Interpretasinya 

0,00 - 0,09 Hubungan korelasinya diabaikan 

0,10 - 0,29 Hubungan korelasi rendah 

0,30 - 0,49 Hubungan korelasi moderat 

0,50 - 0,70 Hubungan korelasi sedang 

> 0,70 Hubungan korelasi sangat kuat 
 

Korelasi Pearson Product Moment (r) merupakan analisis regresi yang sangat populer 

dan sering dipakai oleh mahasiswa dan peneliti. Analisis korelasi ini dikenalkan oleh Karl 

Pearson pada tahun 1900. Korelasi ini digunakan untuk mengetahui derajat hubungan dan 

kontribusi variabel bebas (independent) dengan variabel terikat (dependent). Teknik analisis 

Korelasi PPM termasuk teknik statistik parametrik yang menggunakan interval dan ratio 

dengan persyaratan data dipilih secara acak (random), datanya berdistribusi normal, data yang 

http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
http://statsdata.blogspot.com/
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dihubungkan berpola linier, dan data yang dihubungkan mempunyai pasangan yang sama 

sesuai dengan subjek yang sama.  

Charles Spearman mengenalkan koefisien korelasi tata jenjang ( rank –order 

correlation coeficient). Analisis ini digunakan untuk bahan atau data yang telah terkumpul atau 

dilaporkan berbentuk tata – jenjang, sehingga lebih mudah untuk melakukan analisis. Sebagai 

ilustrasi, seorang peneliti dalam aktivitas analisis mampu menyusun data yang selanjutnya 

dapat dibuat penjenjangan tanpa memperhatikan beda skor, maka kita dapat melakukan analisis 

dan memperoleh nilai r-nya dengan rumus yang lebih sederhana.  

 

C. Uji Korelasi dengan SPSS 

Berikut disajikan data nilai fisika matematika dan nilai fisika kuantum mahasiswa fisika 

FMIPA UNY. 

Fisika Matematika Fisika Kuantum 

45 57 

35 43 

50 62 

40 53 

31 44 

28 40 

58 69 

60 73 

68 79 

75 83 

 

Ujilah apakah ada korelasi yang positif antara kemampuan Fisika Matematika dengan prestasi 

belajar Fisika Kuantum? (Gunakan taraf signifikansi 5%). 

1. Prosedur Analisis 

a. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

b. Isikan di kolom Name “FisikaMatematika” di baris pertama dengan decimals bernilai 

2, dan “FisikaKuantum” di baris ke dua dengan decimals bernilai 2.  

 

c. Pilih Data View dan masukan nilai Fisika Matematika dan Fisika Kuantum sebagai 

berikut.   
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d. Pilih menu Analyze → Correlate → Bivariate. 

e. Masukkan variabel FisikaMatematika dan FisikaKuantum ke kotak Variables sehingga 

akan terlihat seperti berikut. 

 

f. Memilih jenis analisis: Pearson, Kendall’s tau-b, atau Spearman. Dalam hal ini data 

dianalisis dengan menggunakan uji korelasi Pearson. Jika ingin memilih jenis yang 

lain bisa mengeklik tombo; tersebut. 

g. Klik tombol Options → Means and Standard Deviation → Cross Product 

Deviations and Covariance → Continue. 

h. Klik OK sehingga akan muncul hasil analisis. 
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Descriptive Statistics 

 Mean Std. Deviation N 

FisikaMatematika 49.0000 15.97915 10 

FisikaKuantum 60.3000 15.44201 10 

 
Correlations 

 FisikaMatematika FisikaKuantum 

FisikaMatematika Pearson Correlation 1 .993** 

Sig. (2-tailed)  .000 

Sum of Squares and Cross-

products 
2298.000 2206.000 

Covariance 255.333 245.111 

N 10 10 

FisikaKuantum Pearson Correlation .993** 1 

Sig. (2-tailed) .000  
Sum of Squares and Cross-

products 
2206.000 2146.100 

Covariance 245.111 238.456 

N 10 10 

**. Correlation is significant at the 0.01 level (2-tailed). 

 
2. Pembacaan Hasil Analisis 

a. Tabel Descriptive Statistics menampilkan hasil analisis statistik deskriptifnya seperti 

rata-rata per variabel, standar deviasi, dan jumlah sampel. 

b. Tabel Correlations, ada dua tanda dalam penafsiran korelasi melalui nilai koefisien, 

yaitu tanda (+) dan (-) yang berhubungan dengan arah korelasi, serta menyatakan kuat 

tidaknya korelasi.  

Hipotesis Penelitian : 

Ho : Tidak ada hubungan (korelasi) antara dua variabel. 

H1 : Ada hubungan (korelasi) antara dua variabel. 

Ketentuan 

Jika Sig (2-tailed) > ½ α, maka Ho diterima. 

Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 

Atau 

Jika t hitung < t tabel, maka Ho diterima. 

Jika t hitung > t tabel, maka Ho ditolak. 

 

Pada tabel Correlations nilai Sig (2-tailed = 0,000) < ½ α (0,025) maka Ho di tolak. 

Jadi ada korelasi positif kemampuan fisika matematika dengan prestasi fisika kuantum 

semakin tinggi kemampuan fisika matematika semakin tinggi prestasi fisika kuantum. 

 



 

54 Praktikum 7 Analisis Korelasi 

 

Keterangan Tambahan 

Dasar Pengambilan Keputusan dalam Uji Korelasi Spearman: 

1. Jika nilai sig. < 0,05 maka, dapat disimpulkan bahwa terdapat korelasi yang signifikan 

antara variabel yang dihubungkan. 

2. Sebaliknya, Jika nilai sig. > 0,05 maka, dapat disimpulkan bahwa tidak terdapat korelasi 

yang signifikan antara variabel yang dihubungkan. 

 

D. Tugas 

1. Suatu penelitian dilakukan untuk mengetahui apakah ada hubungan antara variabel tingkat 

religiusitas dengan tingkat kenakalan remaja. Penelitian dilakukan dengan mengambil 

sampel sebanyak 9 individu secara random. Data yang diperoleh dapat disusun dalam 

bentuk penjenjangan. Distribusi data sebagai berikut:  

Var.X 12 11 13 14 15 16 19 17 18 

Var.Y 20 21 18 19 17 14 13 15 11 

 

Berdasarkan data tersebut lakukan analisis guna membuktikan hipotesis yang telah 

dirumuskan dengan taraf kesalahan sebesar 5%. Selanjutnya tentukan arah hubungan, 

kekuatan hubungan dan kontribusi X terhadap Y. 

2. Berikut tersaji data tentang variabel X dan variabel Y.  

Var. X  :  12   9   15   8   13   12   13   12   9   9    8   10 

Var. Y  :   5   7    3    7    5     5     4    5    6    7    6    4 

Berdasarkan data tersebut; (a). Rumuskan permasalahan penelitian; (b). Rumuskan 

hipotesisnya; (c). buktikan ada tidaknya hubungan; (d), tentukan arah hubungan; (e). 

Tentukan kekuatan hubungan dan (f). Tentukan kontribusi X terhadap Y.  
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PRAKTIKUM 8 

ANALISIS REGRESI 

 

A. Tujuan 

 Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan analisis regresi data hasil 

penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Analisis Regresi 

Persamaan regresi adalah persamaan matematik yang memungkinkan untuk 

meramalkan nilai-nilai suatu variabel terikat dari nilai-nilai satu atau lebih variabel bebas. 

Regresi ini dapat diterapkan pada semua jenis peramalan, dan tidak harus berimplikasi suatu 

regresi mendekati nilai tengah populasi. 

 

 

      

 

 

Bila diberikan data contoh [(xi, yi); I = 1,2 … n], maka nilai dugaan kuadrat terkecil bagi 

parameter dalam garis regresi sederhana, yaitu : 

ŷ = a + bx 

Regresi linear ganda adalah persamaan regresi yang menggambarkan hubungan antara 

lebih dari satu peubah bebas (X) dan satu peubah  tak bebas (Y) Hubungan peubah-peubah 

tersebut dapat dituliskan dalam bentuk persamaan: 

Y = a + b1 X1 + b2 X2 

Y  : peubah tak-bebas  a  : konstanta 

X1 : peubah bebas ke-1  b1 : kemiringan garis ke-1 

X2 : peubah bebas ke-2   b2 : kemiringan garis ke-2 

  

= a + bxy

Gambar 1.2.1 Garis Regresi
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C. Uji Regresi dengan Aplikasi SPSS  

Berikut disajikan data fasilitas belajar dan motivasi belajar terhadap prestasi belajar 

mahasiswa. 

Fasilitas Belajar Motivasi Belajar Prestasi Belajar 

10 8 89 

8 6 85 

6 6 78 

6 4 74 

4 6 69 

4 10 70 

8 10 85 

6 8 71 

10 12 92 

2 6 56 

4 4 67 

4 4 66 

6 9 78 

10 9 90 

 

Hitunglah berapa besarnya kontribusi bersama seluruh variabel bebas terhadap variabel 

terikatnya, ujilah apakah ada kontribusi tersebut signifikan, bagaimana persamaan garis 

regresinya, dan tafsirkan maknanya, serta ujilah pengaruh secara masing-masing variabel bebas 

secara parsial! (Gunakan taraf signifikansi 5%) 

Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Fasilitas” di baris pertama dengan decimals bernilai 2, 

“Motivasi” di baris ke dua dengan decimals bernilai 2, dan Prestasi di baris ke tiga 

dengan decimals bernilai 2.  

 

 

3. Pilih Data View dan masukan nilai fasilitas belajar, motivasi belajar, dan prestasi 

sebagai berikut.   
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4. Lakukan analisis dengan menggunakan menu Analyze → Regression → Linear. 

5. Masukkan variabel Prestasi ke kotak Dependent dan variabel Fasilitas dan Motivasi ke 

dalam kotak Independent(s) sehingga akan terlihat seperti berikut. 

 

 

6. Klik Ok sehingga muncul hasil analisis sebagai berikut. 

Variables Entered/Removeda 

Model Variables Entered 

Variables 

Removed Method 

1 Motivasi, 

Fasilitasb 
. Enter 

a. Dependent Variable: Prestasi 

b. All requested variables entered. 

 

Model Summary 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate 

1 .978a .956 .948 2.44123 
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a. Predictors: (Constant), Motivasi, Fasilitas 

 

ANOVAa 

Model Sum of Squares Df Mean Square F Sig. 

1 Regression 1417.873 2 708.936 118.957 .000b 

Residual 65.556 11 5.960   

Total 1483.429 13    

a. Dependent Variable: Prestasi 

b. Predictors: (Constant), Motivasi, Fasilitas 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) 49.908 2.169  23.004 .000 

Fasilitas 3.871 .314 .937 12.318 .000 

Motivasi .301 .322 .071 .935 .370 

a. Dependent Variable: Prestasi 

 

Pembacaan Hasil Analisis 

a. Tabel Model Summary menunjukan beberapa hal sebagai berikut. 

1) R = 0,978 artinya koefisien korelasinya sebesar 0,978. Angka ini menunjukkan 

derajad korelasi antara variabel fasilitas belajar dan motivasi belajar dengan prestasi 

belajar. 

2) R Square = 0,956 menunjukkan angka koefisien determinasinya (R2). Artinya 

variansi dalam prestasi dapat dijelaskan oleh fasilias belajar dan motivasi belajar 

melalui model sebesar 95,6 %, sisanya (3,4%) berasal dari variabel lain. Atau 

dengan bahasa sederhana besarnya kontribusi/sumbangan fasilias belajar dan 

motivasi belajar terhadap prestasi belajar adalah sebesar 95,6 %, sisanya 3,4 % 

berasal dari variabel lain. 

3) Adjusted R square = 0,948. Ukuran ini maknanya sama dengan R square,hanya saja 

Adjusted R square ini nilainya lebih stabil karena sudah disesuaikan dengan jumlah 

variabel bebasnya. 

4) Standard Error of The Estimate = 2,44123 yang menunjukkan ukuran tingkat 

kesalahan dalam melakukan prediksi terhadap variabel terikat. 

b. Tabel ANOVAa digunakan untuk menentukan taraf signifikansi atau linieritas dari 

regresi.  
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Hipotesis Penelitian (uji kelinieran) : 

Ho : Tidak terjadi hubungan linier antara variabel predictor (fasilitas belajar dan 

motivasi belajar) dengan variabel dependen (prestasi belajar). 

H1 : Terjadi hubungan linier antara variabel predictor (fasilitas belajar dan 

motivasi belajar) dengan variabel dependen (prestasi belajar). 

Ketentuan 

Jika F hitung > F tabel, maka Ho ditolak. 

Jika F hitung < F tabel, maka Ho diterima. Atau  

Jika Sig < α, maka Ho ditolak. 

Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel ketiga, diperoleh nilai Sig (0,00) < α (0,05), dengan demikian Ho 

ditolak. Dengan demikian ada hubungan linier antara variabel predictor (fasilitas belajar 

dan motivasi belajar) dengan variabel dependen (prestasi belajar). 

c. Tabel Coefficientsa menginformasikan uji Coefficient dan uji konstanta.  

Hipotesis Penelitian (uji koefisien fasilitas belajar) : 

Ho : koefisien fasilitas belajar tidak signifikan. 

H1 : koefisien fasilitas belajar signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 

Jika t hitung < t tabel, maka Ho diterima. 

Atau  

Jika Sig < α, maka Ho ditolak. 

Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel keempat (baris Fasilitas), diperoleh nilai t hitung =  12,318 dan Sig 

= 0,00. Nilai sig (0,00) < α (0,05), dengan demikian Ho ditolak. Dengan demikian 

koefisien fasilitas belajar signifikan. 

Hipotesis Penelitian (uji koefisien motivasi belajar) : 

Ho : koefisien motivasi belajar tidak signifikan. 

H1 : koefisien motivasi belajar signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 

Jika t hitung < t tabel, maka Ho diterima. 

Atau  

Jika Sig < α, maka Ho ditolak. 

Jika Sig > α, maka Ho diterima. 
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Berdasarkan tabel keempat (baris Motivasi), diperoleh nilai t hitung =  0,935 dan Sig = 

0,370. Nilai sig (0,370) > α (0,05), dengan demikian Ho diterima. Dengan demikian 

koefisien motivasi belajar tidak signifikan. 

Hipotesis Penelitian (uji konstanta) : 

Ho : konstanta tidak signifikan. 

H1 : konstanta signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho diterima. 

Jika t hitung < t tabel, maka Ho ditolak. 

Atau  

Jika Sig < α, maka Ho diterima. 

Jika Sig > α, maka Ho ditolak. 

 

Berdasarkan tabel keempat (baris Constant), diperoleh nilai t = 23,004 dan Sig = 0,00. 

Nilai sig (0,00) < α (0,05), dengan demikian Ho diterima. Dengan demikian konstanta 

tidak signifikan. 

Model persamaan regresi diperoleh dari koefisien konstanta dan koefisien variabel yang 

ada di kolom Unstandardized Coefficients B. Berdasarkan tabel ini diperoleh model 

persamaan regresi : Prestasi (Y) = 49,908 + 3,871 x Fasilitas Belajar (X1) + 0,301 x 

Motivasi Belajar (X2) atau Y =.49,908 + 3,871 (X1) + 0,301 (X2). 

 

D. Tugas 

Berikut ini data mengenai pringkat kimia, nilai ujian dan frekuensi membolos dari kuliah kimia 

oleh mahasiswa IKIP Madiun. 

 

 

Tentukan persamaan garis regresinya dengan perhitungan matematis dan aplikasi SPSS!  

Siswa Peringkat Kimia Nilai Ujian Frekuensi Membolos 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

85 

74 

76 

90 

85 

87 

94 

98 

81 

91 

76 

74 

65 

50 

55 

70 

65 

70 

55 

70 

55 

70 

50 

55 

1 

7 

5 

2 

6 

3 

2 

5 

4 

3 

1 

4 



 

61 Praktikum 9 Validitas dan Reliabilitas Instrumen 

 

PRAKTIKUM 9 

VALIDITAS RELIABILITAS INSTRUMEN PENELITIAN 

 

A. Tujuan 

 Setelah mempelajari modul praktikum ini mahasiswa diharapkan: 

1. Memiliki kemampuan menggunakan SPSS untuk melakukan validitas dan reliabilitas data 

hasil penelitian. 

2. Memiliki sikap kritis, kreatif, inovatif, dan mandiri serta cendekia dalam menyelesaikan 

beragam data hasil penelitian dengan menggunakan SPSS. 

 

B. Validitas dan Reliabilitas 

Syarat pokok yang harus dipenuhi untuk setiap alat ukur yang digunakan untuk mengukur 

variabel-variabel yang ingin diukur dalam penelitian adalah validitas dan reliabilitas.  Validitas 

digunakan untuk mengetahui ketepatan dan  kecermatan suatu instrumen tes/item  pertanyaan  

yang diberikan kepada responden/ peserta tes.  Item yang dapat mengukur apa yang hendak 

diukur merupakan item yang valid, sedangkan reliabilitas merujuk pada ketetapan/ keajegan 

alat tersebut dalam menilai apa yang diinginkan.  

Reliabilitas merupakan kemampuan instrumen yang digunakan akan memberikan hasil 

yang relatif sama.  Reliabilitas menunjukkan konsistensi dan stabilitas suatu skor dari suatu 

instrument pengukur. Reliabilitas berbeda dengan validitas karena reliabilitas membahas 

tentang masalah konsistensi, sedangkan validitas membahas tentang ketepatan. Suatu 

kuesioner dapat dikatakan reliable atau handal jika jawaban seseorang terhadap pertanyaan 

adalah konsisten atau stabil dari waktu ke waktu. Uji reliabilitas dimaksudkan untuk 

mengetahui konsistensi hasil pengukuran variabel. Untuk menentukan derajat reliabilitas tes, 

dapat digunakan kriteria sebagai berikut. 

r1.1 ≤ 0,20  : sangat rendah 

    0,20 <  r1.1 ≤ 0,40 : rendah 

    0,40 <  r1.1 ≤ 0,60 : sedang 

    0,60 <  r1.1 ≤ 0,80 : tinggi 

    0,80 <  r1.1 ≤ 1,00 : sangat tinggi 
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C. Uji Validitas dan Reliabilitas dengan SPSS 

1. Uji Validitas 

Validitas  suatu butir pertanyaan dapat dilihat pada hasil output SPSS pada tabel dengan 

judul Item-Total Statistic. Kevalidan masing-masing butir pertanyaan dapat dinilai dari 

Correlated Item-Total Correlation masing-masing butir pertanyaan. Suatu variabel dikatakan 

valid apabila nilai r-hitung yang merupakan nilai dari Correlated Item-total Correlation > dari r-

tabel. Nilai r-tabel dapat diperoleh melalui df (degree of freedom) = n – k, dimana n merupakan 

jumlah responden, dan k merupakan jumlah butir pertanyaan dalam suatu variabel. Alpha yang 

dipergunakan dalam penelitian adalah 5%. 

 

Contoh  

Perhatikan hasil rekap data kuisioner berikut. Tentukan validitas item aspek A nomor 1-12 dari 

hasil rekap kuisioner berikut! 
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Tabel Hasil Rekap Data Kuisioner 

Responden 

Motivasi Belajar Asal Daerah Gaya Belajar Fasilitas Belajar Teman 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 

1 4 4 4 4 4 1 4 4 4 4 2 3 3 3 4 5 3 3 3 3 2 3 4 4 3 4 4 3 3 2 

2 3 3 3 3 3 3 4 4 4 3 2 3 3 3 4 5 3 2 4 5 2 3 2 4 3 2 4 4 5 2 

3 4 4 4 4 4 1 4 3 3 3 3 4 4 2 3 5 2 1 4 4 3 4 2 3 4 2 3 4 4 3 

4 4 4 4 3 4 1 3 4 4 4 3 3 5 2 4 4 3 1 5 3 3 4 2 3 4 2 3 5 3 3 

5 3 3 3 3 3 3 3 4 4 5 4 4 5 3 4 4 4 1 4 3 1 4 2 3 4 2 3 4 3 1 

6 3 3 4 3 3 2 4 3 3 2 2 4 5 3 2 5 2 1 5 4 2 3 3 3 3 3 3 5 4 2 

7 4 4 4 4 4 1 4 3 3 3 2 3 5 3 4 5 2 2 4 4 2 4 2 4 4 2 4 4 4 2 

8 5 4 4 4 4 2 3 4 4 4 2 3 4 4 4 3 2 2 4 4 2 4 2 4 4 2 4 4 4 2 

9 3 4 3 3 4 1 3 3 3 1 3 2 3 3 4 4 2 1 4 3 2 3 2 3 3 2 3 4 3 2 

10 4 4 4 4 4 1 4 3 3 2 2 3 4 4 3 3 2 1 4 3 3 4 2 3 4 2 3 4 3 3 

11 4 4 4 4 4 1 4 4 3 2 2 3 5 3 3 4 2 3 4 3 3 4 3 4 4 3 4 4 3 3 

12 3 3 3 3 3 3 4 4 3 3 3 4 2 3 4 5 3 4 5 4 2 5 2 3 5 2 3 5 4 2 

13 4 4 4 3 4 4 5 4 4 4 2 3 3 2 4 4 3 1 2 4 2 4 2 3 4 2 3 2 4 2 

14 4 4 4 4 4 1 2 3 3 2 2 3 4 3 5 4 2 1 3 5 3 4 3 2 4 3 2 3 4 4 

15 3 3 3 4 3 1 3 4 3 2 3 2 3 3 2 4 3 1 4 4 4 5 3 3 4 4 5 3 2 4 

16 3 3 3 3 3 1 4 4 4 3 4 4 4 4 4 5 2 3 5 3 5 5 2 3 3 5 5 2 2 3 

17 4 4 4 4 4 3 5 4 4 2 3 3 5 4 4 5 4 3 4 5 2 4 2 3 5 2 4 2 2 3 

18 3 3 3 3 3 3 4 4 4 1 4 4 4 2 3 3 3 2 3 5 2 4 3 3 5 2 4 3 2 3 

19 3 3 3 3 3 2 3 2 2 2 3 4 4 2 4 2 2 2 3 4 2 3 2 2 4 2 3 2 3 3 

20 4 3 4 3 3 1 2 4 4 3 3 3 3 4 4 3 3 2 4 4 3 3 2 2 4 3 3 2 2 4 

21 4 3 3 3 3 1 3 0 0 2 3 3 4 4 3 4 3 3 4 4 2 4 2 3 4 2 4 2 2 4 

22 4 4 4 4 4 1 4 4 4 1 4 4 5 2 4 4 3 1 5 3 3 4 2 3 3 3 4 2 2 3 

23 3 3 4 4 3 3 5 3 5 3 4 4 5 3 4 4 4 1 4 3 1 4 2 3 3 1 4 2 2 3 

24 4 3 4 4 3 3 4 5 2 3 3 4 5 3 2 5 2 1 5 4 2 3 3 3 4 2 3 3 3 4 

25 4 4 4 4 4 2 3 5 2 2 4 4 5 3 4 5 2 2 4 4 2 4 2 4 4 2 4 2 2 3 

26 4 4 4 4 4 2 3 4 2 1 4 4 4 4 4 3 2 2 4 4 2 4 2 4 4 2 4 2 2 3 
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27 4 4 4 4 4 2 4 4 3 2 3 3 4 3 5 3 3 1 4 5 4 5 2 3 4 5 4 5 2 3 

28 2 2 3 2 2 3 4 4 2 3 3 4 4 5 5 4 1 2 3 5 2 4 2 3 3 5 2 4 2 3 

29 4 4 4 4 2 2 4 3 2 2 4 4 3 3 4 5 2 1 3 5 2 4 3 2 3 5 2 4 3 2 

30 4 4 4 3 3 1 3 3 3 2 4 3 3 3 4 4 2 1 4 3 2 3 2 3 4 3 2 3 2 3 
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Penyelesaian 

a. Buka aplikasi SPPS dan pilih variable view di bagian bawah kiri. Ketik A1 sampai 

dengan A12 pada kolom name untuk pertanyaan kuisioner aspek A. Isikan pada kolom 

label yaitu pertanyaan 1 sampai dengan pertanyaan 12. 

 

 

b. Klik Data View dan masukkan data hasil kuisioner A1 sampai A12. 

 

 

c. Klik menu Analyze, pilih Scale → Reliability Análisis. 
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d. Pindahkan seluruh Pertanyaan, mulai A1 sampai A12 ke kotak item melalui tombol 

tanda panah diantaranya. 

 

  

e. Klik tombol statistic, kemudian klik item, scale, dan scale if item deleted.  

 

 

f. Selanjutnya klik continue dan Ok. 

Hasil analisis dengan SPSS akan dihasilkan untuk validitas dapat di lihat di tabel item-

total statistics sebagai berikut. 

Item-Total Statistics 

 
Scale Mean if 

Item Deleted 

Scale Variance if 

Item Deleted 

Corrected Item-

Total Correlation 

Cronbach's Alpha 

if Item Deleted 

pertanyaan 1 16.00 3.310 .678 .437 

pertanyaan 2 16.10 3.403 .700 .440 

pertanyaan 3 15.97 3.689 .699 .470 

pertanyaan 4 16.13 3.568 .606 .478 

pertanyaan 5 16.20 3.476 .573 .480 

pertanyaan 6 17.77 5.909 -.347 .900 

 

g. Menentukan nilai r-tabel dengan melihat nilai df (degree of freedom) = n – k, dimana k 

adalah jumlah butir pertanyaan dalam suatu variabel, dan n merupakan jumlah 

responden. Maka df = 30-6 = 24.  Tabel r product – moment (two tailed test) 

menunjukkan bahwa pada df 19 dengan alpha 5%, diperoleh r table sebesar  0,404. 

h. Membandingkan nilai r hitung dengan r tabel sebagai berikut. 

1) r hitung A1 sebesar 0,678 > r table 0,404, kesimpulan valid. 
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2) r hitung A2 sebesar 0,700 > r table 0,404, kesimpulan valid. 

3) r hitung A3 sebesar 0,699 > r table 0,404, kesimpulan valid. 

4) r hitung A4 sebesar 0,606 > r table 0,404, kesimpulan valid. 

5) r hitung A5 sebesar 0,573 > r table 0,404, kesimpulan valid. 

6) r hitung A6 sebesar 0,347 < r table 0,404, kesimpulan tidak valid. 

i. Menghapus pertanyaan yang tidak valid (nomor 6) dari variable view di SPSS (klik 

kanan pilih clear). 

 

 

j. Melakukan uji validitas kembali untuk pertanyaan yang valid, seperti langkah langkah 

diatas. Hasil uji validitas untuk Item Total Statistics sebagai berikut. 

 

Item-Total Statistics 

 
Scale Mean if 

Item Deleted 

Scale Variance if 

Item Deleted 

Corrected Item-

Total Correlation 

Cronbach's Alpha 

if Item Deleted 

pertanyaan 1 14.13 3.637 .808 .866 

pertanyaan 2 14.23 3.702 .855 .855 

pertanyaan 3 14.10 4.231 .734 .885 

pertanyaan 4 14.27 3.995 .693 .891 

pertanyaan 5 14.33 3.816 .695 .892 

 

k. Menentukan nilai r-tabel dari pertanyaan yang valid melalui df (degree of freedom) = n 

– k, dimana k merupakan jumlah butir pertanyaan dalam suatu variabel, dan n 

merupakan jumlah responden. Maka df = 30-5 = 25.  Tabel r product – moment (two 

tailed test) menunjukkan bahwa pada df 24 dengan alpha 5%, diperoleh r table sebesar  

0,396. 

l. Membandingkan nilai r hitung dengan r tabel dari tabel hasil analisis terakhir sebagai 

berikut. 

1) r hitung A2 sebesar 0,808 > r table 0,396, kesimpulan valid. 

2) r hitung A5 sebesar 0,855 > r table 0,396, kesimpulan valid. 

3) r hitung A6 sebesar 0,734 > r table 0,396, kesimpulan valid. 

4) r hitung A7 sebesar 0,693 > r table 0,396, kesimpulan valid. 

5) r hitung A8 sebesar 0,695 > r table 0,396, kesimpulan valid. 
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m. Menyimpulkan bahwa tujuh indikator pertanyaan variabel A yaitu motivasi dalam riset 

pembelajaran IPA di SMP kelas 7 memiliki r hitung yang lebih besar dari nilai r table telah 

valid. 

 

Keterangan 

Uji validitas terhadap seluruh variabel, yaitu seluruh pertanyaan-pertanyaan pada aspek B, C, 

dan D dengan cara yang sama dengan yang diatas. 

 

2. Uji Reliabilitas 

Langkah uji reliability sama dengan langkah uji validitas. Poin yang berbeda adalah output 

SPSS yang menjadi dasar penilaian validitas dengan output SPSS yang menjadi dasar penilaian 

Reliabilitas. Uji validitas dilakukan dengan memperhatikan output Item total statistik, 

sedangkan uji reliabilitas dengan memperhatikan output Reliability Statistics pada kolom 

Cronbach’s Alpha. Reliabilitas suatu konstruk variabel dikatakan baik jika memiliki nilai 

Cronbach’s Alpha > dari 0,60. 

 

Contoh  

Dengan menggunakan data pada contoh 5, tentukan nilai reliabilitas instrumen untuk aspek A. 

 

Penyelesaian 

1. Buka aplikasi SPSS dan masukkan data variabel A yang sudah valid, seperti terdapat 

pada contoh 5.  

 

 

2. Klik menu analyze pilih scale, kemudian klik realiability analysis. 
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3. Memindahkan seluruh pertanyaan ke kolom item dengan menggunakan tombol tanda 

panah yang berada diantaranya. 

 

 

4. Klik tombol statisitik, kemudian aktifkan item, scale, dan scale if item deleted. 

 

 

5. Klik continue dan OK. 

Hasil output SPSS dapat dilihat di tabel realibility statistics sebagai berikut. 

Reliability Statistics 
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Cronbach's Alpha N of Items 

.900 5 

 

Pengukuran yang reliabel akan menunjukkan instrumen yang dapat menghasilkan data yang 

dipercaya. Reliabilitas suatu konstruk variabel dikatakan baik jika memiliki nilai Cronbach’s 

Alpha > dari 0,60. Maka berdasarkan hasil ini dapat dilihat bahwa Cronbach’s Alpha 0.900 > 

dari 0,60. Hal ini berarti jawaban responde untuk variabel A sudah reliabel.  

 

Keterangan 

Uji reliabilitas terhadap seluruh variabel, yaitu seluruh pertanyaan-pertanyaan pada aspek B, 

C, dan D dengan cara yang sama dengan yang diatas. 

 

D. Tugas 

1. Berikut adalah hasil uji coba instrumen penelitian dalam bentuk angket. Ujilah validitas 

dan reliabilitas instrumen yang digunakan! 

Responden 
No Pertanyaan Skore 

1 2 3 4 5 6 7 8 9 10 11 12 

1 4 4 4 4 4 1 4 4 4 4 2 3 

2 3 3 3 3 3 3 4 4 4 3 2 3 

3 4 4 4 4 4 1 4 3 3 3 3 4 

4 4 4 4 3 4 1 3 4 4 4 3 3 

5 3 3 3 3 3 3 3 4 4 5 4 4 

6 3 3 4 3 3 2 4 3 3 2 2 4 

7 4 4 4 4 4 1 4 3 3 3 2 3 

8 5 4 4 4 4 2 3 4 4 4 2 3 

9 3 4 3 3 4 1 3 3 3 1 3 2 

10 4 4 4 4 4 1 4 3 3 2 2 3 

11 4 4 4 4 4 1 4 4 3 2 2 3 

12 3 3 3 3 3 3 4 4 3 3 3 4 

13 4 4 4 3 4 4 5 4 4 4 2 3 

14 4 4 4 4 4 1 2 3 3 2 2 3 

15 3 3 3 4 3 1 3 4 3 2 3 2 

16 3 3 3 3 3 1 4 4 4 3 4 4 

17 4 4 4 4 4 3 5 4 4 2 3 3 

18 3 3 3 3 3 3 4 4 4 1 4 4 

19 3 3 3 3 3 2 3 2 2 2 3 4 

20 4 3 4 3 3 1 2 4 4 3 3 3 
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2. Berikut disajikan hasil uji coba instrumen soal dalam bentuk pilihan ganda. Ujilah 

validitas dan reliabilitas instrumen soal tersebut. 

Responden 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

A 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

B 0 1 1 1 1 1 0 0 0 0 0 0 0 0 0 

C 0 1 1 1 1 1 1 0 0 0 0 0 0 0 0 

D 0 1 1 1 1 1 1 0 1 1 1 1 0 0 0 

E 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

F 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

G 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

H 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

I 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

J 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

K 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

L 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

M 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

N 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

O 0 1 1 1 1 1 1 0 1 1 1 1 1 0 0 

P 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

Q 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

R 1 1 1 1 1 1 1 0 1 1 1 1 1 0 0 

S 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

T 0 0 1 1 1 1 1 0 1 1 1 1 1 0 1 

U 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

V 0 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

W 0 0 1 1 1 1 1 0 1 1 1 1 1 0 1 

X 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 

Y 0 0 1 1 1 1 1 0 1 1 1 1 1 0 1 

Z 0 0 1 1 1 1 1 0 1 1 1 1 1 0 1 

AB 1 1 1 1 1 1 1 0 1 1 1 1 1 0 1 
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